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[bookmark: _Toc342344412]
Charting Tools and Menus 
The entry point for Excel charting is the Insert ribbon. After you have created a chart, three new ribbon tabs appear under the Chart Tools heading. 
· The Design ribbon allows you to choose a different chart type, layout, or style. 
· The Layout tab allows you to add various elements to a chart or remove them from a chart. 
· The Format tab allows you to micromanage individual elements, such as the bevel effect for an individual data series. 

In general, the tabs progress from more general to more specific as you move from the Design tab on the left to the Format tab on the right. Shown below are the icons on the Design, Layout, and Format tabs. 
 

[image: ]Also, you can use many of the formatting icons on the Home tab to format titles and labels on a chart. These same icons appear on the mini toolbar when you select text within a title on a chart. 




[bookmark: _Toc342344413]Using the Insert Tab to Select a Chart Type 
As shown below, the Insert tab offers seven drop-down menus in the Charts group. Each drop-down leads to a variety of chart types. 

[image: ]


[bookmark: _Toc342344414]Using the Chart Expand Icon 
A dialog launcher icon appears in the lower-right corner of some ribbon groups. This icon usually allows you to bypass the ribbon and head straight to a legacy-style dialog box. 
As indicated, the expand icon for the Charts group, Clicking this icon leads to a dialog box that shows all 73 charting types in one place. 

[image: ]




[bookmark: _Toc342344415]Understanding the Chart Thumbnail Icons 
There are 73 chart types available in Excel, these are shown below. 
 
[image: ]

The gallery of 73 chart types might seem like a dizzying array of charts. However, in many cases, there are four variations of a given type. When you understand how Excel uses the light and dark blue icons to show you these four charting types, you can quickly choose from the various thumbnails. 

[bookmark: _Toc342344416]Using Chart Gallery Controls 
The charting tools ribbons contain many instances of a new Office interface element known as a gallery. A gallery control allows you to scroll through options one row at a time or click the open gallery button to see all the choices at one time. 

For example, the Chart Layouts gallery starts by showing three of the available icons: 


There are three control icons on the right side of the gallery. The up and down arrow icons allow you to move through the gallery one row at a time (see below). 

[image: ]Up/Down Icon Controls, for scrolling through options.
· 
More Icon, used to drop open a larger list of options

 


A quick trick is to use the bottom control icon, the More icon. You can click the More icon to cause the gallery to open the entire control, as shown here 

[image: ]
 
 
[bookmark: _Toc342344417]Creating a Chart 
[image: ]The first step in creating a chart is to build a worksheet that contains data to chart. Many business charts are created from summary data. 
 
[bookmark: _Toc342344418]Selecting Contiguous Data to Chart 
It is easiest to create charts when your data is in a contiguous rectangular block of cells. The left column of the dataset should contain the label for each series to be plotted. The first row of the dataset should contain values to be plotted along the category axis. The top-left cell should be blank. The rest of the cells in the dataset should contain values to be plotted. 

In the previous screen shot, the products in B2:B4 will be plotted as individual series on the chart. The years in C1:E1 will be points along the category axis. 

[bookmark: _Toc342344419]Selecting Noncontiguous Data to Chart 
It is helpful, but not necessary, for your data to be in a contiguous range. In the following example, you might want to create a pie chart that includes the category labels in column B and the totals in column F. 

[image: ]
To select data for creating a chart, you follow these steps: 
1 Click in cell B1 and drag to cell B4 in order to select the range of category labels. 
2 While holding down the Ctrl key, click in cell F1 and drag down to cell F4 in order to add F1:F4 to the selection. 
3 If you have additional series to plot, repeat step 2 for each additional series. 

 
[bookmark: _Toc342344420]Creating a Chart by Using the Insert Ribbon Icons 
After you have selected the data to be included in a chart, you click the Insert tab of the ribbon. Seven drop-down menus in the Charts group offer a total of 73 different chart sub types. You can select one of the drop-down menus or click the dialog launcher icon in the lower-right corner of the group. 

The ToolTips in the seven drop-downs are more descriptive than the ToolTips in the Insert Chart dialog. If you are not sure of which chart subtype to use, you can hover your mouse over an icon in a charting drop-down to see a description of that chart subtype 
 
NOTE: Live Preview does not work when you’re selecting a chart type from either the Ribbon or the Charts dialog. You have to choose one type and click in order to create a chart. 
 


Excel charts are now automatically created as embedded charts. A chart appears somewhere in the range currently visible in the window. You will likely have to move most charts after creating them. In the figure below the chart has been created in an annoying location. 

You can also resize a chart to best fit the space by clicking to select it and then dragging a corner handle in or out. 

[image: ]


[bookmark: _Toc342344421]Creating a Chart with One Keystroke 
Early versions of Excel allowed you to create a chart by selecting the data and pressing the F11 key. In response, Excel created a default chart on a new sheet. 
Excel still recognises that F11 shortcut, and it adds an Alt+F1 shortcut, which creates a default chart as a chart object embedded in the current worksheet. The Alt+F1 keystroke is a time saver when you need to create charts that match the Excel default. 

When Excel is installed, the default chart is a 2-D column chart. You can easily change the default chart type to best fit the type of charts you create the most. Here’s how: 

1 Select an existing chart. In the Design ribbon, click the Change Chart Type icon. If you do not have an existing chart in your workbook, click the dialog launcher icon in the Charts group of the Insert ribbon. 
2 Click the chart subtype that is closest to the chart type you want to create. 
3 In the lower-left of the dialog, click Set as Default Chart. Then click Cancel to leave the dialog box. 

After you go through this procedure, you can press F11 or Alt+F1 to create the selected chart type instead of the column chart. 
 
[bookmark: _Toc342344422]Working with Charts 
After creating a chart, you may need to rearrange the data or move the chart to a new location. 

[bookmark: _Toc342344423]Moving a Chart Within the Current Worksheet 
Excel had an annoying habit of locating new charts near the bottom of your data. With a large spreadsheet, you may need to move the chart to the proper location thousands of rows away. Some methods are faster than others. 

There are several ways to move a chart within the current worksheet. 

[bookmark: _Toc342344424]Drag and Drop Method
When a chart is selected, a border appears around the chart. Eight resizing handles appear in the border. To move a chart, you click the border but avoid the resizing handles. You can then drag the chart to a new location. 

Because it is somewhat difficult to click on a thin chart border, you might try clicking inside the chart in order to drag the chart to a new location. This approach works as long as you can click on some whitespace between the plot area and the chart border. 


You can easily drag a chart anywhere in the visible window. If you accidentally drop the chart just a pixel outside of the visible window, the chart boomerangs back to its original position. 

[bookmark: _Toc342344425]Cut and Paste Method
Instead of dragging and dropping, the fastest way to relocate a chart might be to cut and paste it. You follow these steps to quickly move a chart within the current worksheet: 

1 Select a chart. 
2 Press Ctrl+X to cut the chart from the worksheet. 
3 Press F5 to display the Go To dialog. 
4 Type the address of the cell that you want to contain the top-left corner of the chart and click OK. 
5 Press Ctrl+V to paste the chart in the new location. 



[bookmark: _Toc342344426]Reversing the Series and Categories of a Chart 
Excel follows strict rules in deciding whether rows should be series or categories. Luckily, you can reverse this decision with a single button click.
 
If Excel chooses the wrong orientation for the data in a chart, you can click the Switch Row/Column icon in the Design ribbon. Compare the before and after charts below:

[image: ]

You will see that the years have changed from being category labels to being series labels. The products have changed from being series labels to being category labels. 

To reverse the orientation of data in a chart, you click Switch Row/Column. 
 


If your data has more columns of data than rows, the headings in the first row become category labels. 

The Figure below shows, the eight columns of monthly data become category labels, and the three rows become series. 

[image: ]


If your data has more rows than columns, the headings in the first column become category labels. Shown below, the 11 rows of city data become category labels, and the 4 columns become series. 

[image: ]


 


[bookmark: _Toc342344427]Changing the Data Sequence by Using Select Data 
The Select Data icon on the Design ribbon allows you to change the rows and columns of your dataset, and it also allows you to re-sequence the order of the series. When you click this icon, the Select Data Source dialog appears.

[image: ] 

As shown, buttons in the Legend Entries side of the Select Data Source dialog allow you to add new series, edit a series, remove a series, or change the sequence of a series. A single Edit button on the right side of the dialog allows you to edit the range used for category labels. 

To convert the chart shown on previous page to the chart shown on next page, you use the Select Data Source dialog, as follows:
 
1 Select the chart and choose Design, Select Data. The Select Data Source dialog displays. 
2 Click Switch Rows/Columns to move the city names to the left side of the dialog. 
3 Click Alice Springs on the left side and then the up arrow button until Alice Springs is the first series. 
4 Click Broome and then the up arrow button until Broome is the second series. 
5 Continue re-sequencing the cities until they are in the desired order. 
6 On the Horizontal (Category) Axis Labels side of the dialog, click the Edit button. The data initially points to B1:E1. Change the address in the Axis Labels dialog box to an array by entering the four new labels inside curly braces: ={“Summer”,“Fall”,“Winter”,“Spring”}. Click OK to close the Axis Labels dialog box and return to the Select Data Source dialog box. 

The modified chart:
[image: ]
 

[bookmark: _Toc342344428]Leaving the Top-Left Cell Blank 
In the past, Excel would tell you to always leave the top-left cell of your dataset blank before creating a chart. 

This old guideline was that if your series or category labels contained either dates or numeric labels, you should leave the top-left cell blank. Now, if your labels contain values formatted as dates, there is no need to leave the top-left cell blank. In addition, if your data has been converted to a table, using the Format as Table icon on the Home ribbon, it is impossible to leave the top-left cell blank. 

In a few instances, your results improve if the top-left cell is blank. Consider the data in A1:D4 of Figure 1.23. 


[image: ]

The years in B1:D1 are numeric. If you look at A1:D1, you have text in column A, followed by three numbers in B:D. This is remarkably similar to the data in A2:D4. You have text in column A, followed by numbers in B:D. If you create a chart from this dataset, Excel assumes that you do not have series labels and assumes that A1:A4 represent four category labels. This erroneously produces the top chart in the figure. 

Cells A11:D14 in the figure contain exactly the same data as A1:D4, except the Region label was cleared from A11. In this case, Excel correctly sees three series and three categories. 
 
 
[bookmark: _Toc342344429]Moving a Chart to a Different Sheet 
In Excel, charts always start out as objects embedded in a worksheet. However, you might want to display a chart on its own full-page chart sheet. 
There are two options for moving a chart: 
■ Choose the Move Chart icon at the right edge of the Design ribbon. 
■ Right-click any whitespace near the border of the chart and choose Move Chart. 

Either way, the Move Chart dialog appears, offering the options New Sheet and Object In. The Object In drop-down lists all the worksheets in the current workbook. The New Sheet option allows you to specify a name for a new sheet.

[image: ]  
 
NOTE 
When you choose to move a chart to a new sheet, the chart is located on a special sheet called a chart sheet. This sheet holds one chart that can be printed to fill a sheet of paper. You cannot have additional cells or formulas on a chart sheet. 

[bookmark: _Toc342344430]Customising Charts Using the Design Ribbon 
The Design ribbon allows you to quickly customize a chart with just a couple clicks. For example, the Chart Styles gallery allows you to change the colour scheme and effects for the entire chart. 

The Chart Layouts gallery offers professionally designed combinations of chart elements. 

[bookmark: _Toc342344431]Choosing a Chart Layout 
Depending on the chart type you have chosen, the Chart Layouts gallery offers 4 to 12 built-in combinations of chart elements. When you choose a new chart layout from the gallery, you get a predefined combination of title, layout, gridlines, and so on. 
 
The Chart Layouts gallery offers up to a dozen predefined layouts for the current chart type. 
 
[bookmark: _Toc342344432]Choosing a Colour Scheme 
The Design ribbon is also home to the Chart Styles gallery, which offers 48 variations of colour and effects. The gallery has columns for each of the six accent colours, monochrome, and mixed colours. 


[image: ]

As you proceed down the first four rows of the gallery, each style has a bit more extreme effect applied to the bars. The styles in row 2 have a white border around the bars. 
The styles in row 3 have a dark gradient. The styles in row 4 have a glass-like surface on the bars. The styles in row 5 have a dark border around the bars, combined with a light tint in the plot area. The final row has a dark background that is suitable, for example, if you are using the chart in a dark-themed PowerPoint presentation. 

As shown in the figure above, you can choose from eight colour schemes when you use the Chart Styles gallery. 
 
 
[bookmark: _Toc342344433]Modifying a Colour Theme 
You can change to any of the 20 themes or create your own theme in order to easily access new colours and effects. 

On the Page Layout ribbon, you can click the Themes drop-down to choose from the 20 built-in themes. If you choose a new theme from the Themes drop-down, Excel applies a new colour and set of effects to all of the charts in the current workbook. If you want to change only the colours or effects, you can use the Colours or Effects drop-down in the Themes group.
 
[bookmark: _Toc342344434]Creating Your Own Theme 
You might want to develop a special theme. This is fairly easy to do: you basically need to select two fonts and six accent colours. For example, let’s say you want to create a theme to match your company’s colour scheme. The hardest part is probably finding six colours to represent your company because most company logos have two or three colours. The following sections describe how to create a new theme and suggest resources for choosing complementary colours for your company colours.
 
[bookmark: _Toc342344435]Choosing Effects for a Custom Theme 
Open the Effects drop-down on the Page Layout ribbon. You will see three shapes for each theme: a circle, an arrow, and a rectangle. The appearance of the circle provides an indication of the effects used in simple formats (such as from row 1 of the Shape Styles Gallery). The appearance of the arrow provides an indication of the effects used in moderate formats (row 4 of the Shape Styles Gallery). The appearance of the rectangle provides an indication of the effects used in extreme formats (row 6 of the gallery). 

The Figure below shows the Effects drop-down in grayscale. 
[image: ] 

The circle, arrow, and rectangle apply to simple, moderate, and intense layouts, respectively. 
While you can access dialog boxes to control the font and colours in your theme, you simply have to choose one of the 20 built-in effects as a starting point for your new custom theme. 
Choose any theme from the Effects drop-down to start building your custom theme. 

[bookmark: _Toc342344436]Specifying a Theme’s Colours 
To specify new theme colours, you follow these steps: 
1 Select Page Layout, Themes, Colours, Create New Theme Colours. The Create New Theme Colours dialog appears. Remember that a theme is composed of 2 text colours, 2 background colours, 6 accent colours, and 2 hyperlink colours. These 12 colours are shown in the Create New Theme Colours dialog, as shown in Figure 1.32. 
2 To change the first accent colour, choose the drop-down next to Accent 1. The colour chooser appears. 
3 From the bottom of the colour chooser drop-down, choose More Colours. The Colours dialog appears. 
4 On the Custom tab of the Colours dialog, enter values for red, green, and blue, as shown in Figure 1.33. The New colour block shows the colour for the values you entered. Click OK to accept the new colour. 
5 Repeat steps 2–4 for each of the accent colours. 
6 If you want to change the colours for Hyperlink, Followed Hyperlink, and Text, repeats steps 2–4 for any of those. 
7 In the Name box, give the theme a name, such as your company name. 
8 Click Preview to see the theme applied to your workbook. 
9 Click Save to accept the theme. 

[bookmark: _Toc342344437]Specifying a Theme’s Fonts 
To specify new theme fonts, you follow these steps: 

Select Page Layout, Themes, Fonts, Create New Theme Fonts. 
The Create New Theme Fonts dialog appears, as shown below. Remember that a font theme contains a heading font and a body font. 
	[image: ]
 
 
1 Select a font from the Heading Font drop-down. If a custom font is used in your company’s logo, using it might be appropriate. 
2 Select a font from the Body Font drop-down. This should be a font that is easy to read. Avoid stylized fonts for body copy. 
3 Give the theme a name. It is okay to reuse the same name from the colour theme. 
4 Click Save to accept the theme changes. 

[bookmark: _Toc342344438]Saving a Custom Theme 
In order to reuse a theme in other workbooks, you must save it. From the Page Layout ribbon, you select Themes, Themes, Save Current Theme


[bookmark: _Toc342344439]Using a Custom Theme on a New Document 
After saving a custom theme with your company colours, fonts, and effects, the theme will be available to all workbooks, documents, and slide shows on your computer. The next time that you access the Themes drop-down, your custom themes will appear first in the menu, under a heading of Custom. 
Excel automatically generates a thumbnail showing the letter A in your headline font, the letter a in the body text font, and the six accent colours used in the theme. 

After saving a theme and opening PowerPoint or Word, the new custom themes will be available in those applications as well. 



[bookmark: _Toc342344440]Identifying Chart Elements 
Many elements of a chart can be customised. You rarely want to include all the available elements in a single chart because having too many elements takes away from the meaning of the data in the chart. You should judiciously use titles, axes, and gridlines to help the reader understand the data presented in a chart. 

[bookmark: _Toc342344441]Chart Labels and Axis 
[image: ]

■ Chart area—The chart area is the entire range shown. This includes all the area outside the plot area. It is where labels and legends often appear. 
■ Plot area—The plot area is the rectangular area that includes the data series and data markers. 
■ Chart title—The chart title typically appears in a larger font and near the top of the chart. Whereas Excel 2003 always included the chart title outside the plot area, choices in later Excel versions encourage you to have the title overlaying the plot area. 
■ Horizontal axis title—The horizontal axis title identifies the type of data along the horizontal axis. In case it is not clear that “2005 2006 2007” represents years, you can add a horizontal axis title such as the one shown near number 9. 
■ Vertical axis title—It is common to use the vertical axis title along the left side of a chart to identify the units along the axis. In the Figure, the word “Sales” near number 12 is the vertical axis title. 
■ Legend—The legend initially appears to the right of the plot area. It helps identify which colour in the chart represents which series. You can drag the legend anywhere in the chart area or plot area, freeing up space for the plot area to extend further to the right. 
■ Data label—If you want the actual value for each bar or point to appear on the chart, you turn on the Data Labels option. Data labels frequently get overwritten by gridlines and other charting elements. Far too often, I find myself nudging individual data labels so that they can be read. 
■ Data table—Instead of using data labels, you can ask Excel to add a spreadsheet-like data table beneath the plot area. The data table frequently takes up too much space in the chart area and reduces the size available for the plot area. 
■ Horizontal axis—The horizontal or category axis is along the bottom of the chart for column and line charts and along the left side for bar charts. Your main choice is whether the axis contains a time series. If it does, Excel varies the spacing between the points to represent actual dates. 
■ Vertical axis—This is the axis along the left side of the chart in a column or line chart. In some advanced charts, you might have a second vertical axis on the right side of the chart. This axis typically contains values, and your main choice is whether you want the axis scaled in thousands, millions, and so on. 
■ Horizontal gridlines—Horizontal gridlines run horizontally across the plot area and line up with each number along the vertical axis. If you do not have data labels on a chart, the horizontal gridlines are particularly useful for telling whether a particular point is just above or below a certain level. It is best to keep gridlines unobtrusive. Some of the best charts include gridlines in a faint colour so that they do not obscure the main message of the chart. 
■ Vertical gridlines—Vertical gridlines are used less often than horizontal gridlines. If you are considering using them in a line chart or a surface chart, you should consider using drop lines instead. 





[bookmark: _Toc342344442]Chart Analysis Elements 
The Analysis group on the Layout ribbon includes elements that are of particular importance to scientists. However, some of the elements, such as the trendline, can also be useful in business charting. 

[image: ]
 
The following are the analysis elements: 
■ Trendline—If you ask for a trendline, Excel uses regression analysis to fit your existing data points to a statistical line. You can have Excel extend this line into future time periods. In the Figure above, the dotted trendline shows that unless you alter the system-generating actuals, you will likely miss the goal. 
■ Drop lines—Drop lines are vertical lines that extend from the data point to the horizontal axis in either line or area charts. These lines are helpful because they enable the reader to locate the exact point where the line intersects the axis. 
■ Up/down bars—When you are plotting two series on a line chart, Excel can draw rectangles between the two lines. As shown, the actual exceeds the goal in Days 2 through 11, and the up/down bars are shown in a dark colour. The goal exceeds the actual in Days 11 through 15, and the up/down error bars are shown in a contrasting colour. If the up/down error bars seem too wide, you can try using high/low lines. 
■ Error bars—The error bar feature is popular in scientific analysis to show the error of an estimate. You might see these used in business charts to indicate the acceptable tolerance from a quality goal. 



[bookmark: _Toc342344443]Formatting Chart Elements 
When formatting chart elements, you generally start with some of the built-in choices available on the Layout ribbon. This section describes how to do this, as well as how to use the mini toolbar, Home ribbon, Format ribbon, or Format dialog to further customise certain elements. 

[bookmark: _Toc342344444]Formatting a Chart Title 
By default, a chart with more than one series is created without any title, as shown in the upper-right chart in Figure below. 

To add a title, you use the Chart Title drop-down on the Layout tab. Your choices are a centred overlay title or a title above the chart. When you add the title above the chart, Excel has to shrink the plot area to make room for the title (see the lower-right chart below). If your title fits, using a centred overlay title leaves more space for the title, but there is the chance that the words in your title and the points plotted in the series will collide, as they do in the chart shown on the left below. 
 
[image: ]


[bookmark: _Toc342344445]Typing a Title 
After you select a title location from the drop-down, Excel adds the generic “Chart Title” placeholder text to the top of your chart. 
The title is selected by default, so you can immediately start typing the actual title. You see the typed characters appear in the formula bar. When you press the Enter key, Excel replaces “Chart Title” with the words you typed. 

[bookmark: _Toc342344446]Moving a Title 
You single-click a title to select it. Then you move the mouse pointer so that it is above the outline of the title. When the mouse pointer changes to a four-headed arrow, you click and drag the title to a new location. 

Note that the outline contains only four handles instead of the usual eight. This means you cannot use the handles to resize the title bounding box. However, you do have some control over the size of the title bounding box. If you press the Enter key in the middle of the title, you will force the title bounding box to become vertically larger. 

 
[bookmark: _Toc342344447]Formatting a Title with the Format Ribbon 
Many options on the Format ribbon allow you to change the fill, font, and line style used in the title. The settings in the Shape Styles group affect the currently invisible rectangle that surrounds the title. You cannot add a reflection, but all the other settings are available. 

[bookmark: _Toc342344448]Formatting an Axis Title 
Excel has three built-in options for the vertical axis. Figure 2.7 shows these options: Rotated Title (top left), Vertical Title (bottom left), and Horizontal Title (bottom right). 
For a horizontal axis title, the only built-in option is to turn the title on or off. 
[image: ]All the formatting options available for the chart title also apply to the axis titles.  
[bookmark: _Toc342344449]Formatting a Legend 
The built-in choices for the legend include having the legend outside the left, right, bottom, or top of the plot area. If you move the legend to the top or the bottom, Excel rearranges the legend in a horizontal format 
 
[bookmark: _Toc342344450]Formatting Individual Legend Entries 
A new feature in Excel 2007+ is the ability to format or resize the individual legend entries. This is particularly useful when one entry is longer than the others. 
To format an individual legend, you follow these steps: 
1 Click the legend, and the entire legend is selected. 
2 Click the legend entry you want to change. 
3 To change the font size, right-click the text and use the options in the mini toolbar. To change anything else, use the Home ribbon or the Format ribbon. 

[bookmark: _Toc342344451]Using the Format Legend Dialog 
To use the Format Legend dialog, you choose More Legend Options from the Legend drop-down on the Layout ribbon. This dialog allows you to change the fill colour, the border colour, the border styles, and the shadow behind the legend. 


[bookmark: _Toc342344452]Adding Data Labels to a Chart 
The reader of your chart might be able to discern whether one of two adjacent columns is taller than the other. However, it is difficult to compare a column in the centre of a chart with numbers along the left axis. That’s where data labels can be an advantage. This feature works best if you have only a few data points on the chart. 

Traditionally, data labels for a single-series column chart would appear above each column. In Excel 2007+, this choice is known as Outside End. The other built-in choices on the Data Labels tab are Centre, Inside End, Inside Base, and None (see below). 

[image: ]

[bookmark: _Toc342344453]Nudging a Label to Avoid a Gridline 
If your chart has dark gridlines, you may find that the data label appears to be crossed out by the gridline. It is a slightly tedious process to fix the labels, but doing so ensures that your data labels are readable. You follow these steps to nudge a data label out of the way of the gridline: 



1 Click a data label in the chart. Excel selects all the labels for that particular series. 
2 Again click the data label to be moved. Excel now selects just that data label 
3 Carefully position the mouse pointer over the border of the label. When the mouse pointer changes to a four-headed arrow, click and drag the data label above or below the gridline. 

 

[bookmark: _Toc342344454]Adding a Data Table to a Chart 
A data table is a mini-worksheet that appears below a chart. In it, Excel shows the values for each data point in the table. One advantage of a data table is that you can show the numbers that would normally be shown with data labels without adding any elements to the plot area. 

There are two built-in options in the Data Table drop-down on the Layout ribbon: you can show the data table with legend keys or without legend keys. 
The data table takes up a fair amount of space at the bottom of the chart. Putting the legend keys in the table allows you to regain some of that space by eliminating the legend element from the chart. 
In the chart on the left below, the legend keys appear in the chart. In the chart on the right below, the data table appears without legend keys, requiring a separate legend element to appear—in this case, above the chart. This causes the plot area to shrink and makes it more difficult to interpret the data on the chart. 
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[bookmark: _Toc342344455]Formatting Axes 
Unlike the previously described elements, which are fairly cosmetic, the axis options have major ramifications on the display of data and the ability of the chart reader to interpret data in a chart. 

The built-in choices in the Axes drop-down of the Layout ribbon do not begin to touch on the powerful choices in the Format Axis dialog box. To start with, there are four kinds of axes, although the most that you will find in a single chart is three. A pie chart actually has no axes. A radar chart has one axis. A surface chart has three axes. An X-Y chart has two axes. All other charts have two axes, with the possibility of adding an optional third axis. 

The horizontal axis contains the category labels. In most charts, it appears along the bottom of the chart. In most programs, this axis is also referred to as the x-axis. (Note that in a bizarre twist, Microsoft calls this axis the primary vertical axis in a bar chart.) 

Your most important choice for this axis is whether it should be time based or text based. In a chart with a text-based axis, the points along the axis are equally spaced. In a chart that uses a time-based axis, the points are spaced based on the relative time distance between the points. Other choices include selecting whether the data should be plotted left to right or right to left. 

The vertical axis contains the scale for the numbers plotted in the chart. The primary vertical axis generally appears along the left side of the chart. In a bar chart, this axis appears along the bottom of the chart and is called a horizontal axis. Choices for this axis include scaling of the axis, the minimum and maximum value for the axis, and the distance between tick marks on the axis.
 



[bookmark: _Toc342344456]Changing the Scale of an Axis 
Typically, a chart has a vertical axis that runs from zero to a value larger than the largest value in the dataset. This is not ideal for some datasets. 
The chart below shows daily changes in a measurement that typically fluctuates from 802 to 804. 
[image: ]

If you use a zero-based vertical axis, as in the top chart, you cannot make out any variability. If you instead change the vertical axis to run from 801 to 804.5, you can see the daily fluctuations in the value, as shown in the bottom chart in the figure. 




[bookmark: _Toc342344457]Displaying and Formatting Gridlines 
Gridlines help the reader to locate data on a chart. Without gridlines, it is difficult to follow the plotted points over to the vertical axis in order to figure out the value of a point. 

Gridlines work in conjunction with the Major Unit and Minor Unit settings in the Format Axis dialog. The built-in options in the Layout ribbon allow you to turn on major, minor, major and minor, or no gridlines. 

Below shows four versions of the same chart. In this chart, the major axis unit is 50 and the minor axis unit is 10. 

[image: ]

Choosing to display minor gridlines, as in the chart shown in the upper right above, causes Excel to draw 25 horizontal lines on the chart. This seems like overkill as it is difficult to follow the gridlines across the chart. 

Initially, both major and minor gridlines are formatted as 0.75-point lines. This means that selecting Major & Minor Gridlines looks the same as choosing just Minor Gridlines. To make the major gridlines stand out, as in the lower-right chart in the figure, you have to format the major gridlines. 



[bookmark: _Toc342344458]Creating Unobtrusive Gridlines by Using Format Gridline 
Gridlines start out as 0.75-point lines. If you plan to display major and minor gridlines on a chart, you likely want to format the gridlines differently. 
 
Each Format Gridlines dialog box has three tabs: 
■ Line Colour—You can choose a solid-colour line in any colour, a gradient line in a variety of colours, or an automatic line. When you choose a gradient, Excel applies a slightly different shade to each gridline. 
■ Line Style—You can control the width of each gridline, in 0.25-point increments. You can choose Dash Type to make the gridlines appear as dots, dashes, or various combinations. 
■ Shadow—You can add a shadow to your gridlines. Settings allow you to change the shadow colour, transparency, size, blur, angle, and distance. Nothing shouts “chartjunk” more than a shadow on gridlines. 

[bookmark: _Toc342344459]Formatting the Plot Area 
The built-in choices on the Layout menu are to either turn off the plot area, resulting in a white background, or to use a fill of the default colour, as defined by the chart style chosen on the Design ribbon. In many cases, this default is white, so both choices lead to the same result. 

To have better control over the plot area, you have to choose the More Plot Area Options from the built-in menu. Format Plot Area allows you to choose either No Fill, Solid Fill, Gradient Fill, or Picture or Texture Fill. 

[bookmark: _Toc342344460]Using a Gradient for the Plot Area 
[image: ]
Here is the Fill Gradient options dialog.
The first set of choices involves choosing whether the gradient should be linear, radial, or rectangular, or whether it should follow a predefined path. 
Within the linear gradients, you can specify a direction, such as 90 degrees for top to bottom, or 180% for right to left. 

With the radial and rectangular gradients, you can specify whether the gradient radiates from the centre or from a particular corner. 

The path type creates a shape similar to using Rectangular, from Centre. 
 
The next choices involve the number of colours. You can either choose a predefined colour scheme from the Pre-set drop-down, or you can specify your own colour scheme by defining a number of gradient stops. Each stop is assigned a colour, a transparency, and a position ranging from 0% to 100%. You can edit only one gradient stop at a time. 

[bookmark: _Toc342344461]Creating a Custom Gradient 
To set up a two-colour gradient, you follow these steps. 
1 Select a chart. From the Layout tab, choose Plot Area, More Plot Area Options. 
2 Change the Fill setting from Automatic to Gradient Fill. 
3 Choose Linear gradient. 
4 Change the angle to 90 degrees. 
5 Open the Gradient Stops drop-down. If there are more than two stops, select the last stop and click Remove. Continue removing any stops higher than Stop 2. 
6 Choose Stop 1 from the drop-down. Choose a green colour. Set the stop position at 5%. Set the transparency to 25% to make a lighter green. 
7 Choose Stop 2 from the drop-down. Choose white as the colour. Set the stop position at 95%. 

The result is a two-colour gradient ranging from dark green at the top to white at the bottom. 
 

[bookmark: _Toc342344462]Using a Picture or Texture for the Plot Area 
You now have many more options available when you want to use a texture or a picture for the plot area. When you choose Picture or Texture Fill, a Texture drop-down appears, with the same two dozen textures that have been in Office for years. To use a picture instead, you click the File button and browse your drives to locate a picture to insert. 

When you choose a picture, it is stretched or shrunk to completely fill the plot area. This might end up causing your logo to be a little squashed.

To make your picture keep its correct aspect ratio, you choose the Tile Picture as Texture check box in the Format Plot Area dialog. 

When you choose to tile the picture, you have a number of choices available in the Tiling Options section. 
 


[bookmark: _Toc342344463]Controlling 3-D Rotation in a 3-D Chart 
You have a number of options for rotating a 3-D chart. Of the available options, you are most likely to change the X rotation and leave the other angles alone: 
[image: ]

■ X rotation—You can choose a value from 0 to 359.9 degrees to rotate the floor of the chart counter clockwise. The chart at the top-right above has been rotated 30 degrees from the default rotation. This rotation forces the series names to move clockwise to the left. In some cases, you might be able to better see a short series by rotating the x-axis. 

■ Y rotation—You can choose a value from –90 degrees to 90 degrees to change the height of the viewer with respect to the chart. In the default 15% Y rotation, it appears that the reader is slightly above the chart. For a 0-degree rotation, the view appears as if you are at about eye level with the chart, as shown in the chart at the top left below. 
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■ Perspective—You can choose a value from 0 to 120 in order to further distort a chart. If you have ever used a wide-angle lens on a camera, you might have noticed that items in the foreground appear unusually large, while items in the background appear unusually small. Increasing the perspective is similar to using a wide-angle camera
■ Depth—You can choose a value from 0% to 2000% of the base. Decreasing the ratio of depth to the base creates a chart where the columns become wide rectangles. 
■ Height—You can uncheck the Autoscale check box to enable the Height setting. You can choose a value from 0% to 500% of the base. 


[bookmark: _Toc342344464]Forecasting with Trendlines 
A trendline attempts to fit existing data points to a formula and extend that formula into the future. When you add a trendline to a chart, Excel uses least-squares regression to find the best line to represent the data points. 

Excel can either draw the trendline for existing points to indicate whether the points are trending up or down, or it can extend the trendline into the future to project whether you will meet a goal. 
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Above, actual progress toward a goal is tracked in column B. Note that because the project is in process, several points in the dataset are not yet filled in. 



[bookmark: _Toc342344465]Add a Trendline
To add a trendline, you select Layout, Trendline, Linear Trendline. 
Excel asks to which series it should add a trendline. 

If you choose the actual series, Excel adds a new virtual series to the chart. This series is plotted out to the end of the data series. 
Although creating a trendline requires only a few clicks, there are several trendline options worth learning. These are described in the following sections. 

[bookmark: _Toc342344466]Formatting a Trendline 
To format a trendline, you right-click the trendline and choose Format Trendline. 

Options in the Format Trendline dialog allow you to change the line colour and the line style. 
 
[bookmark: _Toc342344467]Trendline Forecast Methods 
In business, you most often use a linear trendline, which assumes a constant rate of progress throughout the life of the chart. Several other forecast methods are available for trendlines: 
Formatting Chart Elements 

■ Exponential—An exponential trendline, most often found in science, describes a population that is rapidly increasing over successive generations, such as the number of fungi in a Petri dish over time. 
■ Logarithm—A logarithmic trendline results when there is an initial period of rapid growth that levels off over time. 
■ Polynomial—This trendline can describe a line that undulates due to two to six external factors. When you specify a polynomial trendline, you have to specify which order of polynomial. For example, in a third-order polynomial, the line is fit to the equation y = b + c1x + c2x2 + c3x3. 
■ Power—A power trendline fits the points to a line, where y = cxb. This describes a line that increases at a specific exponential rate over time. 
■ Moving average—A moving average trendline is used to smooth out data that fluctuates over time. A typical trendline would use a three-month moving average. 



[bookmark: _Toc342344468]Chart Drop Lines
[bookmark: _Toc342344469]Adding Drop Lines to a Line or Area Chart 
Area and line charts are great at showing trends, but it is often difficult for the reader to figure out the exact values for data points. Because the line is floating in space, you are counting on the viewer’s eye being able to travel from the horizontal axis straight up to the data series line. 

A drop line is a vertical line that extends vertically from a line or area chart and extends down to the horizontal axis. As shown in the lower chart below, the drop lines help you see that the March point is exactly at 300. This would be difficult to discern in the chart shown at the top of the figure. 

To add a drop line, you select the chart and then choose Layout, Lines, Drop Lines. 
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[bookmark: _Toc342344470]Up and Down Bars
[bookmark: _Toc342344471]Adding Up/Down Bars to a Line Chart 
If you have a line chart with two different data series, you might want to compare those series at each point along the horizontal axis. There are two different options for this, available in two locations along the Layout tab of the ribbon. 

In the lower chart in the Figure below, high-low lines extend from one line to the other line. These are created using Layout, Lines, High-Low Lines.
 
In the chart at the right, up/down bars extend from one line to the other line. These bars appear in contrasting colours, depending on which line is higher at that particular point. 

[bookmark: _Toc342344472]Add Up/Down Bars
To add up/down bars, you choose Layout, Up/Down Bars, Up/Down Bars.
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[bookmark: _Toc342344473]Error Bars
[bookmark: _Toc342344474]Showing Acceptable Tolerances by Using Error Bars 
Excel makes it easy to add error bars: 

1 Select one series in the chart and choose Layout, Error Bars, More Error Bar Options. 
2 In the Format Error Bars dialog, you can choose whether the error bars should extend up, down, or both from the line. You can add a cap or have no cap.
3 In the lower section, you can specify one of five methods for calculating the size of the error bar. You can specify that the error bars should extend a fixed number of units, base this on standard deviation, and so on. 
4 Click Close
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[bookmark: _Toc342344475]Formatting a Chart Series 
In order to format the series, you use the Current Selection drop-down on the left side of either the Layout or Format ribbon. Choose the appropriate series from the list to select the series. Click the Format Selection button to access the Format Data Series dialog. 
 
There are alternate ways to format the data series. Right-click and choose Format. 


[bookmark: _Toc342344476]Two-Y Axis Chart
The Series Options category allows you to plot a series on a secondary axis. This is useful if your one data series contains data that is of a different order of magnitude than the other series. 

For example, you might chart revenue and gross profit percent. By moving the gross profit percent to the Secondary Axis, you can see detail of revenue in millions and gross profit percentages in the 50% range. 

Below we see that the Primary Axis on the left Y axis is 0 to 6, and the Secondary Y-Axis is 0 to 40. The Chart type for the secondary axis has been changed to show a line style.
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[bookmark: _Toc342344477]Formatting a Single Data Point 
The first click on a data series selects the entire series. If you pause for a moment and then perform a second click on a data point, the Current Selection drop-down indicates that you have selected an individual data point. The drop-down might say Series “Profit” Point “2006”. 

After selecting a data point, use the Format Selection button located on the left side of the Layout or Format ribbon. You can then change the colour or marker style of a single point. 



[bookmark: _Toc342344478]Converting Text to WordArt 
You use the WordArt Styles group on the Format ribbon to apply WordArt styles to any text on a chart. You are not allowed to use the type-twisting options in the Transform menu, but you can add shadow, glow, or reflection to the 20 styles in the WordArt menu. 

[bookmark: _Toc342344479]Using the Shape Styles Gallery 
The Shape Styles gallery contains 36 built-in styles that can be applied to any shape. There are really six styles for each of the six accent colours in the current theme. 

To quickly format a particular element, you click that element and choose a new style from the gallery. 
When using the Shape Styles gallery, keep these tips in mind: 

■ The colours and effects available in the gallery change if you select a new theme from the Page Layout ribbon. 
■ The first time you click a column, you select the entire series. A second click selects only one column or data point. 
■ If you find it difficult to select a particular item on a chart, you can select the item from the Current Selection drop-down at the left edge of the Format ribbon. 
■ Live Preview works in this gallery. Although you see the effect after hovering over a tile in the gallery, you actually have to click the tile to apply the style. 
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This shows the Shape Styles gallery 
 



[bookmark: _Toc342344480]Replacing Data Markers with Clip Art or Shapes 
Rather than using columns or cylinders for your data markers, you can use a different shape, such as a Drawing Shape or clip art. 
To achieve this effect, you can change the fill of a data series and then turn off the border around the data point. 

[bookmark: _Toc342344481]Using Clip Art as a Data Marker 
Follow these steps to create a pictograph: 
1 In a 2-D column chart, select a data series. Right-click the data series and choose Format Data Series. 
2 In the Format Data Series dialog that appears, choose the Fill category in the left panel. In the right panel, choose Picture or Texture Fill. 
3 Click the Clip Art button. Excel displays a shortened version of the clip art pane, called Select Picture. 
4 Select the Include Content from Office Online check box. 
5 In the Search Text box, type a keyword to describe the clip art and then click Go. 
6 Browse through the returned images. You are looking for something that is cartoonish and, preferably, narrow. Rather than clip art with a detailed background, look for clip art where only the character appears. When you find an acceptable image, click OK. 
7 Click the Border Colour category and choose No Line. 
8 Click Close to close the Format Data Series dialog. 
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[bookmark: _Toc342344482]Use Shapes as Chart Markers 
Follow these steps to create the top chart shown above: 
1 Create a 2-D column chart. 
2 Select a cell in the worksheet. From the Insert menu, choose an upward arrow from the Shapes drop-down. 
3 Click and drag to draw an arrow on the worksheet. 
4 Right-click the shape and choose Copy 
5 Click the data series in the chart. Right-click and choose Format Data Series. 
6 In the Format Data Series dialog that appears, choose the Fill category in the left panel. In the right panel, choose Picture or Texture Fill. 
7 In the Insert From section, click the Clipboard button. Excel replaces the columns with the arrows. 
8 Click Close to close the Format Data Series dialog. 

[bookmark: _Toc342344483]Creating Charts That Show Trends 
[bookmark: _Toc342344484]Choosing a Chart Type 
You have two excellent choices when creating charts that show the progress of some value over time. Because Western cultures are used to seeing time progress from left to right, you are likely to choose a chart where the axis moves from left to right— whether it’s a column chart, line chart, or area chart. 

If you have only a few data points, you can use a column chart. Column charts work easily for 4 quarters or 12 months. Within the column chart category, you can choose between 2-D and 3-D styles. If you want to highlight one component of a sales trend, you can use a stacked column chart. 
 
When you get beyond 12 data points, you should strongly consider switching to a line chart. A line chart can easily show trends for hundreds of periods. Line charts can be designed to show only the data points as markers or to connect the data points with a straight or smoothed line. 




[bookmark: _Toc342344485]Using a Meaningful Chart Title 
If you are a data analyst, you are probably more adept at making sense of numbers and trends than are the readers of your chart. Rather than hoping that the reader will discover the message you are trying to make, why not add the message as the title of the chart? 
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Follow these steps to remove the legend, add data labels, and add a meaningful title: 

1 From the Layout ribbon, choose Legend, None and then choose Data Labels, Outside End. 
2 Click the title in the chart. Click again to put the title in Edit mode. 
3 Backspace to remove the current title. Type Market share has improved, press Enter, and type 13 points since 2002. 
4 To format text while in Edit mode, you would have to select all the characters with the mouse. Instead, click the dotted border around the title. The border becomes solid. You can now use the formatting icons on the Home ribbon to format the title. 
5 On the Home ribbon, choose left-justified and then click the Decrease Font Size but-ton until the title looks right. 
6 Click the border of the chart title and drag it so the title is in the upper-left corner of the chart. 

The result, shown on the next page provides a message to assist the reader of the chart. 
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[bookmark: _Toc342344486]Highlighting a Section of Chart
The chart below shows a sales trend over one year. The business was affected by road construction that diverted traffic flow from the main road in front of the business. 
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The title calls out the July and August time period, but it would be better to actually highlight that section of the chart. 

Follow these steps to add an area chart series to the chart: 

1 Begin a new series in column C, next to the original data. To highlight July and August, add numbers to column C for the July and August points, plus the previous point, June. In cell C7, enter the formula of =B7. Copy this formula to June, July, and August. 
2 Click the chart. A blue bounding box appears around B2:B13 in the worksheet. Drag the lower-right corner of the blue bounding box to the right to extend the series to include the three values in column C. Initially, this line shows up as a red line on top of a portion of the existing blue line. 
3 On the Layout ribbon, use the Current Selection drop-down to choose Series 2. This is the series you just added. 
4 While Series 2 is selected, choose Design, Change Chart Type. Select the first area chart thumbnail. Click OK. Excel draws a red area chart beneath the line segment of June through August. 
5 On the Format ribbon, use the Current Selection drop-down to reselect Series 2. Then choose Shape Fill, White, Background 1, Darker 25%. 

The top chart below shows the grey highlight extending from the horizontal axis up to the data line for the two line segments. 
Alternatively, you could replace the numbers in column C with 70,000 in order to draw a grey rectangle behind the months, as shown in the bottom chart. 
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[bookmark: _Toc342344487]Add Automatic Trendline to Charts 
Sometimes, you may want to allow Excel to make a prediction based on past results. For such situations, Excel offers a trendline feature. 

Excel can draw a straight line that fits the existing data points. You can either ask Excel to extrapolate the trendline into the future, or, if your data series contains blank points that represent the future, Excel can automatically add the trendline. 

The easiest way to add a trendline is to build a data series, the following example includes all the days that the project is scheduled to run. In the Figure below, column A contains the days of the month. Column B contains 125 for each data point; Excel therefore draws a straight line across the chart, showing the goal at the end of the project. Column C shows the writing progress I should make each day. In this particular month, I am assuming that I would write an equal number of pages six days per week. Column D is labelled Actual; this is where I record the daily progress toward the goal.

[image: ] 
The chart is created as a line chart. Gridlines are removed. The legend is removed. 


The trendline is formatted as a lighter grey. The actual line is formatted as a thick line. The top chart shown above shows the chart before the trendline is complete. You can see that the thick line is not quite above the progress line. 
 
[bookmark: _Toc342344488]Add a trendline 
1 Right-click the series line for the Actual column. Choose Add Trendline. 
2 The Format Trendline dialog offers to add exponential, linear, logarithmic, polynomial, power, or moving average trendlines. Choose a linear trendline. 
3 In the Trendline Name section, either leave the name as Linear (Actual) or enter a custom name, such as Forecast. 
4 For the settings where you can forecast forward or backward a certain number of periods, because this chart already has data points for the entire month, leave both of those settings at 0. There are also settings where Excel shows the regression equation on the chart. Add this if you desire. 
5 Right-click the trendline to select it. On the Format ribbon, choose Shape Outline, Dashes and then select the fourth dash option. Also choose Shape Outline, Weight, 3⁄4 point. 

The trendline is shown in the bottom of the above figure. In this particular case, the trendline extrapolates that if I continue writing at the normal pace, I will miss the deadline by 15 pages or so. 


Be Careful 
Excel’s trendline is not an intelligent forecasting system. It merely fits past points to a straight line and extrapolates that data. It works great as a motivational tool. The current example shows,for example, that it would take a few days of above-average production before the trendline would project that the goal would be met.
 


[bookmark: _Toc342344489]Creating Charts to Show Differences 
The following describe using pie, 100% stacked column, and the other charts. 
 
[bookmark: _Toc342344490]Pie Charts 
Pie charts are great for comparing two to five different components. You typically select a range containing category labels in column A and values in column B. Often, the categories are sorted so that the largest value is at the top and the remaining categories are sorted in descending order. 

To create a pie chart, from the Insert ribbon, you select the Pie drop-down, as shown below. There are six icons in this drop-down: 
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■ 2-D Pie—This is the type that you use most frequently. 
■ 2-D Exploded Pie—There is no need to choose this because you can easily explode a pie or a slice of pie later. This technique is discussed later in this chapter, in the section “Highlighting One Slice of a Pie by Exploding.” 
■ Pie of Pie or Bar of Pie—Both of these chart types are effective for dealing with datasets that have too many slices and when you care about the small pie slices. 
■ 3-D Pie—This is a regular pie chart tipped on its side so that you end up seeing the “edge” of the pie. This is a cool effect when you are trying to decorate a PowerPoint chart. It is not as effective if you actually want someone to read your charts to understand the data. 
■ Exploded Pie in 3-D—Again, this is an option you probably don’t want to choose because you can easily explode a pie by using techniques discussed later in this chapter. 

The default pie chart has no labels and includes a legend on the right side to help identify the pie slices. Initially, the first data item appears starting at the 12 o’clock position, and additional wedges appear in a clockwise direction, as shown here. 
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In black and white especially, it is difficult to match up the tiny colour swatches used in the legend with the pie slices. You almost always want to delete the legend and add data labels, as discussed in the next section. 

Excel offers seven built-in layouts for a pie chart. All the layouts that include labels add them inside the pie slices. In the current example, the black font on the dark pie slices disappears. 


[bookmark: _Toc342344491]Labelling a Pie Chart 
Because a pie chart does not have a lengthy axis running along one edge of the chart, choosing the data labels is an important consideration. 

Rather than using the built-in Data Label choices on the Layout ribbon, you choose More Data Label Options from the Data Labels drop-down on the Layout ribbon. 

Excel displays the Label Options page of the Format Data Labels dialog, as shown below. 
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You have options for what the label should contain. You can choose more than one of the following options: 

■ Series Name—This option doesn’t make sense in a pie chart because every slice would have a series name such as “Sales.” 
■ Category Name—You choose this option to show the names of items represented by the individual pie slices. When you turn this item on, you can set Legend to None. 
■ Value—You choose this option to show the actual numeric value for this slice from the cells in the spreadsheet. You often choose either Value or Percentage. 
■ Percentage—You choose this option to have Excel calculate the percentage of the pie allocated to each pie slice. This is a number that is not typically in your spreadsheet. 
■ Show Leader Lines—You should leave this setting on. If you later reposition a label, Excel draws a line from the label to the pie slice associated with that label. 

For the Label Position option, the usual choices for a pie chart are either to show the label outside the pie slice, indicated by Outside End, or inside the pie slice, indicated by Centre. 

The final choice in the Label Options page of the Format Data Labels dialog is the Separator drop-down. This option becomes important when you have chosen two items in the Label Contains section. If you have chosen Category Name and Percentage, for example, Excel’s default choice for a comma as the separator shows the label East, 33%. To remove the comma from the pie chart labels, you choose either (space) or (New Line) from the Separator drop-down. 

[bookmark: _Toc342344492]Rotating a Pie Chart 
You have control over the rotation of a pie chart. You can right-click a pie chart and choose Format Data Series. On the Options dialog that appears, you can change the setting for Angle of First Slice. In Figure 4.12, for example, the bottom pie chart has been rotated 195 degrees, preventing labels from appearing on top of each other. 
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[bookmark: _Toc342344493]Moving Individual Pie Labels 
In a pie chart that has long category names and many slices, you may not be able to find an angle of rotation that enables all the labels to have sufficient room.

In this case, you need to move an individual pie slice label. 


The first time you click a data label, all the data labels are selected, a second click on a data label selects only that particular label. 

You can click the border of the label and drag it to a new position. If the Leader Lines option remains selected, Excel automatically connects the label and the pie slice with a leader line. 

You can use the Home ribbon icons to format all labels. 
 
[bookmark: _Toc342344494]Exploding One Slice of a Pie
The first click on a pie selects the data series (that is, it selects all the pie slices). If you then drag outward from the centre of the pie, you explode all the slices of the pie. 

A second click selects only a single slice. 

You drag outward while a data series is selected and the single slide will move. Below is showing a single slice moved, or “Exploded”.

[image: ]
 
 


[bookmark: _Toc342344495]Change Colour of Single Slice 
Instead of exploding a slice of a pie, you can highlight that slice using a contrasting colour. A single black pie slice in an otherwise white pie instantly draws the reader’s eye. 

To format the chart: 
1 Click anywhere on the pie to select the entire pie. 
2 On the Format ribbon, choose Shape Fill, White. The entire pie disappears. 
3 On the Format ribbon, choose Shape Outline and then select black. The pie is now a white pie outlined in black. 
4 Click the one pie slice that you want to highlight. 
5 On the Format ribbon, choose Shape Fill and then select black. The single pie slice now stands out from the other slices. 

Using a Doughnut Chart to Compare Two Pies 
Excel offers another chart type—the donut chart—that attempts to compare multiple pies. In a donut chart, one pie chart encircles another pie chart. 
A reader of the chart in Figure 4.21 can see that the market share for OurCo increased between 2006 and 2007 and that the market share for Comp B decreased between 2006 and 2007. It is unlikely that the reader could draw any conclusions about Comp A based on this chart. 
Creating Charts That Show Differences 
Figure 4.21 
Doughnut charts are generally difficult to read, although this one does effectively communicate some information. 
 
 
In creating the chart in Figure 4.21, you would have to go through a number of maddening steps, including these: 
■ You need to select Layout, Data Labels, More Data Label Options and choose to show only the series name as the label. You almost need to leave the legend turned on with this chart because there isn’t space to fit OurCo 2006 in the thin ring of the pie. 

■ Changing the colours using the Format ribbon is a tedious process. You cannot format both OurCo sections at once. You have to click the 2006 ring, then 2006 OurCo, then Format, Shape Fill, and then select black. You then have to repeat these steps for the other five pieces of the doughnut chart. 
■ To make some data labels white, you have to select the labels for Series 1, then just one label, then use the Font Colour drop-down on the Home ribbon. You repeat this step for OurCo for Series 2. 

One interesting setting for the doughnut chart is the doughnut hole size. When you right-click the inner series of the doughnut chart and choose Format Data Series, the Format dialog box appears, where you can change the doughnut hole size (valid values range from 10% to 90%). The doughnut chart in Figure 4.22 uses a hole size of 10%. Reducing the hole size makes the chart more readable in this case. 
 

[bookmark: _Toc342344496]Waterfall Charts
A waterfall chart breaks a single component chart out over several columns. 

[image: ]

[bookmark: _Toc342344497]Creating a Waterfall Chart.

The trick to making the middle columns float is to use a stacked column chart. The second series is the actual columns that appear on the chart. The first series is changed into an invisible colour without any lines in order to make the bars in the second series appear to float. 

You may start with values such as those shown in columns A and B in the figure below. The trick to creating a waterfall chart is to move those values into two series. 
The second series is the height of each column that is actually seen. 

The first series is an invisible column that makes the other bars appear to float. 
[image: ]
A waterfall chart can be used in many situations to turn a single component column chart into a whole-page chart. These charts present a dramatic picture of all the components in a process. 


1. You follow these steps to create the chart shown above:
2. For the three columns in the chart that touch the horizontal axis, set the invisible column to zero and the visible column to the number from column B.
3. The goal for trade discount is to have a floating bar that extends from 62,280 down to 34,254. In order to have the bar float at this level, you need an invisible bar that is 34,254 tall. Therefore, in cell E3, enter the formula =F4.
4. The height of the floating bar needs to extend from 34,254 to 62,280, so enter the formula =F2-E3 in cell F3.
5. After the Net Revenue bar are all the SG&A expenses. The height of each floating bar should be the amount of the expense. Therefore, in cell F5, enter the formula =B5. Copy this down to cells F6:F9.
6. The formula for the invisible portion of the bars is often difficult to figure out. In this case, starting at the final bar might make this easier. The Travel bar representing $600 needs to float just above the Profit bar of 9,441.Thus, enter the formula =F10 in cell E9.
7. The Royalties bar of 4,700 needs to float just above the level of the Travel bar. The height of the Travel bar is the height of the invisible bar (9441 in E9) and the height of the visible bar (500 in F9).Therefore, in cell E8 enter =E9+F9.You now have a formula that can be copied.
8. Copy cell E8 to the blank cells in E7:E5.
9. Select the range D1:F10. From the Insert ribbon, choose Column, Stacked Column.
10. Turn off the legend by selecting Legend, None from the Layout ribbon.
11. Click the lower Trade Discount bar. On the Format ribbon, choose Shape Fill, White. The lower columns disappear.
12. Select the top column. On the Format ribbon, choose Shape Fill and then select black.
13. Turn off the gridlines by selecting Gridlines, Primary Horizontal Gridlines, None on the Layout ribbon.
14. Right-click a top column and choose Add Data Labels. (Normally, you would choose to put the data labels at the outside end. However, because this is a stacked column chart, the outside end is not an option in the Format Data Labels dialog.)
15. Individually grab each label and move it to the top of the column.
16. To finish the waterfall chart, you need to draw connecting lines from the bottom of one column to the next column. Therefore, on the Insert ribbon, choose Shapes, Line. While holding down the Shift key, draw a line from the top of the first column to the top of the next column. Select Format, Shape Outline and then select black to darken the line. Repeat this step to connect all the columns.

[bookmark: _Toc342344498]XY Scatter Charts
Use XY scatter charts to plot pairs of data points.
The example below shows a table of average January temperatures for selected U.S. cities.

[image: ]

What are the likely causes of variability in January temperature? You might theorize that the most likely cause would be distance from the equator.

Below, a new column B shows the latitude of each city. This dataset is perfect for an XY scatter chart. The latitudes in column B represent an independent variable. 
The temperatures in column C represent a dependent variable. A scatter chart plots one data marker for every pair of latitude and temperature data. 

In this case, the latitude will be plotted along the x-axis, and the temperature will be plotted along the y-axis

[image: ]

[bookmark: _Toc342344499]Adding a Trendline to a Scatter Chart 
To add a tight grid and a trendline to a scatter chart, you choose Layout 3 from the Chart Layouts gallery on the Design ribbon. 

The trendline represents the best-fit line, given the data points. If the trendline is angled diagonally from bottom left to top right, it indicates that the x and y variables appear to be directly related. If the trendline is angled from top left to bottom right, it indicates that the x and y variables appear to be inversely related.


View the chart below, the trendline confirms that there is an inverse relationship between temperature and latitude. 
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[bookmark: _Toc342344500][bookmark: _GoBack]Using SmartArt Graphics and Shapes 
[bookmark: _Toc342344501]Understanding SmartArt Graphics and Shapes 
Images and artwork provide an interesting visual break from tables of numbers. Excel offers a broad new array of business diagramming tools. The SmartArt graphics in Excel helps you to communicate messages about your organization and processes. 

While SmartArt graphics allow you to create diagrams quickly, they have one annoying limitation in Excel: The text in the shapes is static, so there is no way to link the text in a SmartArt shape to a value calculated in an Excel formula. 

This limitation means that to get the most out of SmartArt graphics, you have to understand how to use shapes in your worksheet. 

■ SmartArt—SmartArt is a collection of similar shapes, arranged to imply a process, groups, or a hierarchy. In former versions of Excel, SmartArt was known as Diagrams. As in the past, with Excel it is easy to add new shapes, reverse the order of shapes, and change the colour of shapes. 

Office includes a text editor that allows for Level 1 and Level 2 text for each shape in a diagram. Many styles of SmartArt include the capability to add a small picture or logo to each shape. 

■ Shapes—You can add interesting shapes to a document. A shape can contain words; it is the only art object in which the words can come from a cell on the worksheet. You can add glow, bevel, and 3-D effects to shapes. In previous versions of Excel, shapes were known as AutoShapes. Microsoft has added some new shapes as well as several formatting properties. 

■ WordArt—You use WordArt to present ordinary text in a stylised manner. You can use it to bend, rotate, and twist the characters in text. In Excel, you can add glow, bevel, and material effects. WordArt has been completely redesigned from previous versions of Excel. A limited version of WordArt is available for formatting titles and labels in Excel charts. 

 


[bookmark: _Toc342344502]Using SmartArt 
You use SmartArt to show a series of similar shapes, where each shape represents a related step, concept, idea, or grouping. SmartArt in Excel is an enhanced version of business diagrams from previous versions of Excel. In Excel, Microsoft has addressed many of the shortcomings of business diagrams, including the following: 

■ Each shape has an associated text editor. 
■ Shapes can contain Level 1 text for headlines and Level 2 text for body copy. 
■ Some styles now allow shapes to include an image. 
■ Automatic settings in SmartArt can automatically resize the text in all shapes to allow the longest text to fit. 
■ SmartArt styles allow you to apply glow and bevels to an entire SmartArt diagram. 


The goal of SmartArt is to allow you to create a great-looking graphic with minimal effort. After you define a SmartArt image for your text, you can quickly change to any of the other 84 styles by clicking the desired style in the gallery. Figure 11.1 shows four different SmartArt styles: 

■ Basic Process—In this style, all text is typed as Level 1. 
■ Accent Process—This style puts the Level 1 text in the background and highlights the Level 2 text in the foreground boxes. 
■ Picture Accent Process—This style gives equal weight to the Level 1 and Level 2 text. Pictures are added behind each shape. 
■ Picture Accent List—Unlike the process charts, a list chart does not include arrows to indicate a process. 



If you want to fine-tune the text in a particular shape, you can use the Format ribbon to micromanage any element in the SmartArt. 


[image: ]

Note the following in the above diagram:
Subtle differences in 4 of the 84 possible SmartArt styles give more weight to either Level 1 or Level 2 text. Notice that the Level 1 text is prominent (top), in the background (second), small (third), or vertical (bottom). 
 


[bookmark: _Toc342344503]Elements Common Across Most SmartArt 

A SmartArt style is a collection of two or more related shapes. In most styles, you can add additional shapes in order to illustrate a longer process. 

A few styles are limited to only n items. Each shape can contain a headline (Level 1 text), body copy (Level 2 text), and a graphic. Some of the 84 styles show only Level 1 text. If you switch to a style that does not display Level 2 text and then switch back, the shape remembers the Level 2 text it originally had. 

Some of the SmartArt styles can include pictures. You should add pictures after you have selected your final style. Changing layout styles always causes pictures to be lost, so you should finalize a layout before adding the images. Some styles include arrows between shapes to illustrate a process. 
 

CAUTION 
If you insert pictures in a layout, switch to another layout, and then back to the original layout without closing the document, your pictures do come back. This is somewhat of a privacy concern. After you save and close the document, the hidden pictures are removed. 

While you’re editing SmartArt, a text pane that is slightly reminiscent of PowerPoint appears. You can type some bullet points in the text pane. If you demote a bullet point, the text changes from Level 1 text to Level 2 text. If you add a new bullet point, Excel adds a new shape to the SmartArt. 


[bookmark: _Toc342344504]SmartArt Categories 
The SmartArt gallery groups the 84 SmartArt layouts into 7 broad categories:
 
■ List—This category is designed to show a nonsequential list of information. Variations include horizontal, vertical, and bending lists. Some lists include chevrons, and some include pictures. In general, these styles do not include arrows between shapes. 
■ Process—This category is designed to show a sequential list of steps. Variations include horizontal, vertical, bending, equations, funnels, gears, and several varieties of arrows. Some process charts allow the inclusion of images. Most styles include arrows or other connectors in order to convey a sequence. 


■ Cycle—This category is designed to show a series of steps that repeat. It includes cycle charts, radial charts, a gear chart, and a pie chart. 

■ Hierarchy—This category is designed to show organization charts, decision trees, and other hierarchical relationships. Variations include horizontal and vertical charts and charts with and without connecting lines. 

■ Relationship—This category is designed to show a relationship between items. Many of the layouts in this category are duplicated from the other six categories. This category includes examples of arrow, chart, cycle, equation, funnel, gear, hierarchy, list, process, pyramid, radial, target, and Venn chart layouts. 

■ Matrix—This category is designed to show four quadrants of a list. Only two options exist: either four quadrants with a central element or four quadrants. 

■ Pyramid—This category is designed to show containment, overlapping, proportional, or interconnected relationships. 
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[bookmark: _Toc342344505]Creating SmartArt Chart Shapes
[bookmark: _Toc342344506]Inserting SmartArt 
Although there are 84 different layouts of SmartArt, you follow the same basic steps to insert any SmartArt layout: 

1 Select a cell in a blank section of the workbook. 
2 From the Insert ribbon, choose SmartArt from the Illustrations group. The Choose a SmartArt Graphic dialog appears. 
3 From the left side of the Choose a SmartArt Graphic dialog, select a category. 
4 Click a SmartArt type in the centre of the Choose a SmartArt Graphic dialog. 
5 Read the description on the right side. This description tells you whether the layout is good for Level 1 text, Level 2 text, or both. In Figure 11.3, you can see that the Vertical Chevron List layout is good for large amounts of Level 2 text. 
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Shown above the information for each style provides information about whether a particular style is appropriate for more Level 1 or Level 2 text. 
 
 


6. Repeat steps 4 and 5 until you find a style suitable for your content. Then click OK. 

[image: ]

As shown here, an outline of the SmartArt is drawn on the worksheet. The flashing insertion cursor is in the first item of the text pane. One element of the SmartArt is selected. 

When you type text at the flashing insertion point, it is added to the selected shape. 


7. Fill in the text pane with text for your SmartArt. You can add, delete, promote, or demote items by using icons in the SmartArt Tools, Design, Create Graphic group. The SmartArt updates as you type more text. 

In many cases, adding a new Level 1 item adds a new shape element to the SmartArt. If you add longer text to the SmartArt, Excel shrinks all the elements in order to make the text fit. 

8. Make the entire SmartArt graphic larger, if needed, by grabbing the resizing handles in the corners of the SmartArt and dragging to a new size. After you resize the graphic, Excel resizes the text to make it fit in the SmartArt at the largest size possible. 

9. If you like, change the colour scheme of the SmartArt, which initially appears in one colour. To do so, from the SmartArt Tools Design ribbon, select Change Colours from the SmartArt Styles group. Excel offers several versions of monochromatic styles and five styles of colour variations for each shape. 

10. Choose a 2-D or 3-D style from the SmartArt Styles gallery on the Design ribbon. The Inset and Cartoon styles have a suitable mix of effects but are readable. 

11. Move the SmartArt to the proper location. Position the mouse over the border of the SmartArt, avoiding the eight resizing areas. The cursor changes to a four-headed arrow. Click and drag the SmartArt to a new location. If you drag the SmartArt to the left side of the worksheet, the text pane moves to the right of the SmartArt. 

12. Click outside the SmartArt. Excel embeds the SmartArt graphic in the worksheet and hides the SmartArt ribbons. Figure 11.5 shows some completed SmartArt. 
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[bookmark: _Toc342344507]Changing the Colour of SmartArt

The Design ribbon’s Change Colours drop-down offers 38 different colour schemes for each theme. 
Five options in the Colourful category offer to mix up the colours used for each shape. Thirty other options offer five varying shades of each of six accent colours. 

The Design ribbon offers a large gallery of 14 different SmartArt styles. There are five 2-D styles in a section labelled Best Fit for Document. There are also nine 3-D styles. 

Choosing a style from the gallery applies a different mix of bevel, shadow, transparency, gradient, reflection, and glow to all shapes. The built-in styles range from subtle to outlandish. Some of the later 3-D styles, such as Bird’s Eye Scene and Brick Scene, are very hard to read. 

Below shows a Continuous Arrow Process graphic with the 14 different styles applied. 
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[bookmark: _Toc342344508]Changing Existing SmartArt to a New Style 
There are a couple of ways to change SmartArt to a new style: 

■ You can left-click the SmartArt and then choose the SmartArt Tools, Layouts from the Design ribbon to choose a new layout. As shown in the diagram below, the Layouts drop-down initially shows only the styles that Excel thinks are a close fit to the current style. 

If you want to access the complete list of styles, you have to select More Layouts. The advantage of this method is that Live Preview shows you the changes before you commit to a style. 

[image: ] 
 
■ A faster way to access the complete list of styles is to right-click between two shapes in the SmartArt and choose Change Layout from the context menu. 

This step is a little tricky because you cannot click an existing shape; you must click inside the SmartArt border—but on a section of the SmartArt that contains nothing. 


[bookmark: _Toc342344509]Micromanaging SmartArt Elements 
There are two ribbons for SmartArt tools: the Design and Format ribbons. 

The Design ribbon allows you to change the overall design of the SmartArt. 
If you stay on the Design ribbon, Microsoft makes sure that your SmartArt looks good. It keeps the font for all Level 2 text consistent for all shapes. 

It keeps all the shapes proportional. If you have a particular need to override some aspect of one shape, however, you can do so on the Format ribbon. 
 
CAUTION 
When you change any setting on the Format ribbon, Microsoft turns off the automatic formatting for the other elements. 
Changing a setting on the Format ribbon is a great way to make horrible-looking SmartArt. If you absolutely have to use the Format ribbon, you should first get your SmartArt as close as possible to the final version by using the Design ribbon. 


[bookmark: _Toc342344510]Changing Text Formatting in One Element 
In Automatic mode, Excel chooses a font size that is small enough to show the longest text completely. This can cause problems if you have one shape with long text and short text everywhere else. 

In this case, Excel chooses a small font size for the long text and then forces all the other items to have the same tiny text as well. In such a situation, you might want to override the text size for the shape that has the longest text. Excel then automatically resizes the font size in the remaining automatic shapes to be larger. 

The mini toolbar is useful for making these types of changes. You select the text either directly in the shape or in the text pane. Immediately after you complete the selection, you should watch for an almost-transparent formatting box to appear. Then you immediately move the mouse to the box to prevent it from disappearing. You can then change the font size by using the drop-down in the mini toolbar. If you allow the mini toolbar to disappear, you can use the formatting tools on the Home ribbon to change the font size.
 
In the figure below, the long Level 2 text in step 4 was resized. Excel then calculated the proper text size for steps 1 through 3, resulting in the text in the top three shapes automatically growing to a larger font size. 
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When you manually override the font size in the fourth shape, the text in the remaining three shapes automatically becomes larger. 
 
 
[bookmark: _Toc342344511]Changing One Shape 
There are many items you can edit for a SmartArt shape. To see how this works, you can click any shape in the SmartArt and then try the following: 

■ Use the green handle to rotate the shape. 

■ Use the resize handles to resize the shape. 

■ Use the move handle to nudge the shape. 

■ Choose Change Shape from the Format ribbon to change the outline to a different shape. 

■ Choose settings from the Shape Styles group to change fill, outline, and effects for the shape. 

■ Choose settings from the WordArt Styles group to change the text inside the shape. 

■ Right-click the shape and choose Format Shape to have complete control over the shape. 



In general, SmartArt created on the Design ribbon looks uniform and neat. When you move to the Format ribbon, the possibility for chaos arises. For example, the SmartArt below contains mixed effects, font sizes, and rotation; it was created in the Format ribbon. 
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After experimenting with the Format ribbon, you can choose Reset Graphic on the Design ribbon to turn the SmartArt back into something more uniform. 
 


[bookmark: _Toc342344512]Exporting Charts
You should note the following concerns with copying the charts:
 
■ Privacy—Even though you copy just the chart, Excel brings along all the data in the entire workbook. This means that the recipient of your PowerPoint presentation can right-click the slide and open a complete copy of all 50 worksheets in your workbook. 

■ Links—Depending on how the chart is pasted, the recipient might need to have a copy of the underlying workbook if he or she wants to edit the chart. 

■ Live data—If you want the chart in PowerPoint to reflect the current values from the Excel file, you have to have access to the Excel file. 

There are at least eight different ways of getting charts from Excel to PowerPoint or Word. Considering all the positives and negatives, it’s a better option to copy the underlying chart data from Excel to PowerPoint and re-creating the chart in PowerPoint. 
This method requires a few extra steps, but it allows you to have an editable chart without sending along the entire 50MB workbook. 

The following shows some of the methods and the advantages and disadvantages of each method. 
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[bookmark: _Toc342344513]Copying a Chart Linked to the Original Workbook 
Copying a chart as a live chart linked to the original workbook is the easiest method of getting a chart from Excel to PowerPoint. You basically just copy the chart from Excel and paste it to PowerPoint. 

With this method, you have full access to all the Charting Tools ribbon tabs in PowerPoint. You can customize the chart to match the theme of the PowerPoint presentation, and you can choose new layouts, styles, and so on. 
The data remains linked to the original workbook. If you change the workbook and later open the PowerPoint presentation, the chart reflects the new numbers from the Excel workbook. 

Obviously, this feature works only if the PowerPoint presentation still has access to the original Excel file. Otherwise, PowerPoint shows a static version of the last-known numbers in the chart. 

To copy the chart, you follow these steps: 
1. Open both PowerPoint and Excel. 
2. In Excel, click the chart. 
3. Press Ctrl+C or click the Copy icon on the Home ribbon. 
4. Switch to PowerPoint by pressing Alt+Tab. 
5. Paste by pressing Ctrl+V or clicking the Paste icon on the Home ribbon. 
The chart fills the text area of the slide. The Chart Tools ribbon icons are available, as shown below. 
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Copying and pasting is the simplest method for getting a chart from Excel to PowerPoint. 
 
 
[bookmark: _Toc342344514]Copying a Chart Linked to a Copy of Original Workbook 
The problem with a straight copy and paste is that the PowerPoint slide and the original Excel workbook must remain on the same computer in order to maintain the link. If you plan on distributing the PowerPoint file to others, you can copy the chart along with the entire workbook. 

To copy the chart, you follow these steps: 
1 Open both PowerPoint and Excel. 
2 In Excel, click the chart. 
3 Press Ctrl+C or click the Copy icon on the Home ribbon. 
4 Switch to PowerPoint by pressing Alt+Tab. 
5 Paste by pressing Ctrl+V. 
6 An icon appears at the lower-right corner of the pasted chart. Hover over the icon, and a drop-down arrow appears. Click the drop-down arrow. Choose Excel Chart (Entire Workbook), as shown in Figure 12.2. 

One advantage of this method is that you can send the PowerPoint presentation to any recipient whose computer has Office. The recipient can right-click the chart, choose Edit, and see the entire Excel workbook. If that person makes changes to the assumptions in the workbook, the chart updates. The recipient also has full access to the Charting Tools ribbons in PowerPoint. 
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[bookmark: _Toc342344515]Copying a Chart as a Picture 
You can paste a picture of a chart in a PowerPoint slide. The picture is initially the same size as the chart in the Excel worksheet. Instead of having access to the Charting Tools ribbon, you only have access to the Picture Tools ribbon. 

The Picture Tools ribbon might allow you to change the chart to grayscale or a monochrome colour, but you do not have access to the rich chart formatting tools. 

To paste a chart as a picture, you copy the chart in Excel. On the PowerPoint slide, you can perform either of the following tasks: 

■ Press Ctrl+V to paste the chart. Then use the drop-down arrow to the lower right of the chart and choose Paste As Picture. 

■ Select the drop-down arrow on the Paste icon in the PowerPoint Home ribbon. Choose Paste Special and then those to paste the picture as PNG, GIF, JPEG, bitmap, Enhanced Metafile, or Windows Metafile. 

The Paste Special dialog is shown below. 
[image: ]

After the chart is pasted as a picture, you can use any of the settings on the Picture Tools Format ribbon to apply a frame, bevel, shadow, or reflection to the chart.
[bookmark: _Toc342344516]
SPARKLINES 
[bookmark: _Toc342344517]What are Sparklines? 
Unlike charts on an Excel worksheet, Sparklines are not objects — a Sparkline is actually a tiny chart in the background of a cell. Because a Sparkline is a tiny chart embedded in a cell, you can enter text in a cell and use a Sparkline as its background.

You can apply a colour scheme to your Sparklines by choosing a built-in format from the Style gallery (Design tab, which becomes available when you select a cell that contains a Sparkline). 

You can use the Sparkline Colour or Marker Colour commands to choose a colour for the high, low, first, and last values (such as green for high, and orange for low).

[image: ]

When one or more Sparklines are selected, the SPARKLINE TOOLS APPEAR, displaying the DESIGN tab. 

Data presented in a row or column is useful, but patterns can be hard to spot at a glance. The context for these numbers can be provided by inserting Sparklines next to the data. Taking up a small amount of room, a Sparkline can display a trend based on adjacent data in a clear and compact graphical representation. Although you don’t have to have a Sparkline cell directly next to its underlying data, it is a useful. 

[image: ]

You can quickly see the relationship between a Sparkline and its underlying data, and when your data changes you can see the change in the Sparkline immediately. In addition to creating a single Sparkline for a row or column of data, you can create several Sparklines at the same time by selecting multiple cells that correspond to underlying data.


[bookmark: _Toc342344518]Create Sparklines 
You can also create Sparklines for rows of data that you add later by using the fill handle on an adjacent cell that contains a Sparkline. 
One advantage of using Sparklines is that, unlike charts, Sparklines are printed when you print a worksheet that contains them. 

[bookmark: _Toc342344519]Create a Sparkline 
1. Select an empty cell or group of empty cells in which you want to insert one or more Sparklines. 
2. On the INSERT tab, in the SPARKLINES group, click the type of Sparkline that you want to create: LINE, COLUMN, or WIN/LOSS. 
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3. In the DATA box, type or select the range of the cells that contain the data on which you want to base the Sparklines. 
4. In the LOCATION RANGE box select where you want your Sparklines placed 
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5. Click on OK

You do not select data labels as in normal charts merely the actual data for your Sparklines. 
You can click to temporarily collapse the dialog box, select the range of cells that you want on the worksheet, and then click to restore the dialog box to its normal size. 

After you create Sparklines, you can control which value points are shown (such as the high, low, first, last, or any negative values), change the type of the Sparkline (Line, Column, or Win/Loss), apply styles from a gallery or set individual formatting options, set options on the vertical axis, and control how empty or zero values are shown in the Sparkline. 


[bookmark: _Toc342344520]Remove a Sparkline 

1. Select a Sparkline or multiple Sparklines. 
2. Use the dropdown arrow on the CLEAR button in the GROUP group on the DESIGN ribbon. 
3. Make a selection of what you wish to clear 
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4. Selected Sparklines are deleted. 




[bookmark: _Toc342344521]Customise Sparklines 

On the DESIGN tab, you can choose one or more of several commands from among the following groups: 
SPARKLINE, TYPE, SHOW/HIDE, STYLE, and GROUP.

Use these commands to create a new Sparkline, change its type, format it, show or hide data points on a line Sparkline, or format the vertical axis in a Sparkline group. 
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[bookmark: _Toc342344522]Axis options 
[bookmark: _Toc342344523]Set axis options 

If your data range includes dates, you can: 
Select your Sparkline. 
Select DATE AXIS TYPE from the AXIS options on the DESIGN ribbon to arrange the data points on the Sparkline to reflect any irregular time periods. 


· E.G. If your first three data points are each separated by exactly one week and the fourth data point is one month later, the space between the third and the fourth data points is increased proportionally to reflect the greater time period. 
· You can also use the AXIS options to set minimum and maximum values for the vertical axis of a Sparkline or Sparkline group. 
Setting these values explicitly helps you control the scale so that the relationship between values is shown in a more meaningful way. 
· You can also use the Plot Data Right-to-Left option to change the direction in which data is plotted in a Sparkline or Sparkline group. 

[bookmark: _Toc342344524]Control which value points are shown 

You can highlight individual data markers (values) in a line Sparkline by making some or all of the markers visible. 

1. Select your Sparkline / Sparklines. 
2. Go to the show group on the design ribbon and make one or more of the following choices: 
[image: ]

· To show all values, select the MARKERS check box. 
· To show negative values, select the NEGATIVE POINTS check box. 
· To show the highest or the lowest values, select the HIGH POINT or LOW POINT check boxes. 
· To show the first or the last values, select the FIRST POINT or LAST POINT check boxes. 
[image: ]

Note: Clearing a check box hides the specified marker or markers 








[bookmark: _Toc342344525]Change the style or format Sparklines 
Use the Style gallery on Design tab, which becomes available when you select a cell that contains a Sparkline. 

[image: ]


1. Select a single Sparkline or a Sparkline group
2. To apply a predefined style, on the DESIGN tab, in the STYLE group, click a style or click the arrow at the lower  right corner of the box to see additional styles. 
3. Make a selection.
4. To manually apply formatting to a Sparkline, use the SPARKLINE COLOUR or the MARKER COLOUR commands. 
[image: ]


[bookmark: _Toc342344526]Sparkline titles 
1. Click on a cell that contains a Sparkline type in the title you wish for it. 
2. Press return.
3. Format title as you would for text in a cell so as not to obscure your Sparkline.

[image: ]


[bookmark: _Toc342344527]Handle empty cells or zero values 
You can control how a Sparkline handles empty cells in a range by using the Hidden and Empty Cell Settings dialog box. 


1. Click on the edit data drop down arrow in the Sparkline group on the design ribbon. 
[image: ]

2. From the menu select HIDDEN & EMPTY CELLS a dialog appears. 
[image: ]

3. Select from the options how you want your empty data cells to appear within your Sparkline 
4. Click on OK 


[bookmark: _Toc342344528]Chart Templates
It is sometimes required to have a standard company chart template design to avoid having to repeat certain formatting and styles.

It also should be noted that chart templates do not save data, only formatting, and layout of all elements are stored in the template. 

Assume a template is created from a chart that contains a title. When the template is applied the resulting chart will have a title in same location and with the same formatting as the chart used to generate the template, however, the default text of "Title" will appear in the element since the title's data has not been stored in the template.

[bookmark: _Toc342344529]Create a Chart Template
Insert a chart to use as a starting point for your template. Note that chart templates can be created and used in any of the three Office applications that have the shared charting engine: Excel, PowerPoint, and Word.

Format the chart the way you normally would until the chart has the desired appearance. In this example the following modifications to the chart have been made:

· Applied a custom fill color to the series
· Deleted the legend
· Removed the horizontal axis line
· Set the horizontal axis maximum to 10
· Changed the line color of the gridlines and vertical axis line
· Reversed the categories order on the vertical axis
· Set the horizontal axis crosses at setting to maximum value
· Added a chart title and entered the title text
· Changed the chart titles font to be the same color as my series
The resulting chart:
[image: http://officeblogs.net/excel/02_21_08-Chart1.jpg]


[bookmark: _Toc342344530]Save the chart template

1. With the chart selected, click on the Design tab in the Ribbon
2. Click on the "Save As Template" button located in the Type section
[image: ]
3. Enter a template name and click Save
[image: ]

[bookmark: _Toc342344531]Steps to Use a chart template

1. Select the data for your chart
2. Click on the Insert tab in the Ribbon
3. Open the Insert Chart dialog
4. Select the "All Chart Types" option from the bottom of any dropdown in the Charts section
Tip: if you have an existing chart you can select the "Change Chart Type" option to launch the same dialog

Select the Template tab from the top of the left navigation menu
[image: ]
5. Select a chart template from those listed on the right side of the dialog
6. Select "OK" to apply the template
7. Complete the chart by adding back the text elements that were not saved in the chart template.
[bookmark: 1228][bookmark: ch11le][bookmark: _Toc342344532]Printing Charts
[bookmark: idx-CHP-9-1012][bookmark: idx-CHP-9-1011][bookmark: idx-CHP-9-1013][bookmark: idx-CHP-9-1014]How you print a chart depends on the type of chart you've created. You can print embedded charts either with worksheet data or on their own. 

Standalone charts, which occupy separate worksheets, always print on separate pages.

[bookmark: orm9780596528324-CHP-9-SECT-2.5.1][bookmark: _Toc342344533]Embedded charts
You can print embedded charts in two ways. The first approach is to print your worksheet exactly as it appears on the screen, with a mix of data and floating charts. 
In this case, you'll need to take special care to make sure your charts aren't positioned over any data you need to read in the printout. 

To double-check, use Page Layout view
Choose View Ribbon > Workbook Views > Page Layout.
[image: ]

You could also print out the embedded chart on a separate page, which is surprisingly easy. 
Just click the chart to select it, and then choose Office Button >Print. 

When you do so, Excel's standard choice is to print your chart using landscape orientation, so that the long edge of the page is along the bottom, and the chart's wider than it is tall. 

Landscape is usually the best way to align a chart, especially if it holds a large amount of data, so Excel automatically uses landscape orientation no matter what page orientation you've configured for your worksheet. If you want to change the chart orientation, select the chart, then choose:
Page Layout > Page Setup > Orientation > Portrait. 

Now your chart uses upright alignment, just as you may see in a portrait-style painting.
[bookmark: orm9780596528324-CHP-9-NOTE-6]Note: If you select an orientation from the Page Layout > Page Setup Orientation list while your chart is selected, you don't end up configuring the orientation for the worksheet itself. Instead you configure the embedded chart's orientation when you print it out on a separate page. If you want to configure the orientation for the whole worksheet, make sure nothing else is selected when you choose an orientation. 
Excel also includes some page setup options that are specific to charts.

To see these options, head to the Page Layout > Page Setup section, click the dialog launcher in the bottom-right corner to show the Page Setup dialog box, as shown below:

[image: ]

Choose the Chart tab (which appears only when you've got a chart currently selected). You'll see an option to print a chart using lower print quality ("Draft quality"), and in black and white instead of colour ("Print in black and white").

[bookmark: orm9780596528324-CHP-9-SECT-2.5.2][bookmark: _Toc342344534]Standalone charts
[bookmark: idx-CHP-9-1016][bookmark: idx-CHP-9-1015]If you're using a standalone chart, your chart always prints out on a separate page, sized to fit the whole page. 

To print out just the chart page alone (rather than the whole workbook), switch to the chart's worksheet, and then choose Office Button > Print. 

To print out the entire workbook which prints your data worksheet and chart worksheet on different pages look in the "Print what" section and select the "Entire workbook" option.

Excel automatically sets all chart worksheets to Landscape orientation, which orients the page so that the long edge runs horizontally across the bottom. If this layout isn't what you want, before you print the chart, choose Page Layout >Page Setup >Orientation >Portrait.
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